ACD/ChemSketch
Version 4.0 for Microsoft Windows

User’s Guide

Drawing Chemical Structures
and
Graphical Images
# Table of Contents

## 1. Introduction

1.1 What is ACD/ChemSketch

1.2 What’s New

1.2.1 Version 3.5 → 4.0

1.2.2 Version 2.5 → 3.5

1.2.2.1 Full Integration with Other Software

1.2.2.2 New Features in the ChemSketch Interface

1.3 About This Guide

1.4 Useful Definitions

1.5 Demo Versions

1.6 Freeware Version

1.7 For More Information...

1.7.1 How to Get Hold of Us

## 2. Basics of ACD/ChemSketch

2.1 Objectives

2.2 System Requirements

2.3 Starting ACD/ChemSketch

2.4 Exiting ACD/ChemSketch

## 3. Drawing Simple Structures

3.1 Structure Mode and Draw Mode

3.2 Using the Draw Normal Tool

3.3 Using the Draw Continuous Tool

3.4 Using Mouse Drag

3.5 Using the “Clean” Command

3.6 Using the Stereo, Coordinating and Undefined Bond Tools

3.7 Editing Atom Labels

3.8 Inserting Labels and Using the Expand Option in Structure Drawing

3.9 Using the Draw Chains Tool

3.10 Flipping Structures

3.11 Selecting, Rotating, and 3D Rotating

3.12 Clearing the Screen

## 4. Drawing More Complex Structures

4.1 Using the Table of Radicals

4.2 Using Ring Structures
4.3 Deleting Atoms and Fragments ......................................................................................................... 24
  4.3.1 Deleting atoms individually: ......................................................................................................... 24
  4.3.2 Deleting all the atoms simultaneously ............................................................................................. 24
4.4 Replacing Atoms ..................................................................................................................................... 24
4.5 Setting Double and Triple Bonds ......................................................................................................... 25
4.6 Setting Charges ....................................................................................................................................... 26
4.7 Displaying Atom Properties .................................................................................................................. 27

5. Advanced Structures ............................................................................................................................... 28
  5.1 2D Optimization .................................................................................................................................... 28
    5.1.1 Creating the Structure of Cyclic Alkanes ..................................................................................... 28
    5.1.2 Creating the Structure of a Cyclic Peptide .................................................................................. 29
  5.2 3D Optimization .................................................................................................................................... 30
    5.2.1 Creating the Structure of Bicyclo[2.2.2]octane ........................................................................ 31
    5.2.2 Creating the Structure of Triptycene ......................................................................................... 32
    5.2.3 Creating the Structure of Cubane ............................................................................................... 34
    5.2.4 Creating the Structure of Dodecahedrane ([5]Fullerene-C_{20}) ............................................ 35

6. Advanced Drawing: Templates ................................................................................................................ 38
  6.1 Instant Template Tool ........................................................................................................................... 39
    6.1.1 Creating the Structure of a Cyclic Oligomer .............................................................................. 39
  6.2 Table of Radicals in Structure Drawing ............................................................................................... 41
    6.2.1 Creating the Structure of Fluorescamine .................................................................................... 41
  6.3 Templates from the Template Window .................................................................................................. 43
    6.3.1 Creating the fragment of a DNA molecule .................................................................................. 43
      6.3.1.1 Drawing the chain of deoxyriboso-5-phosphate fragments ...................................................... 43
      6.3.1.2 Adding the bases .................................................................................................................. 44
  6.4 Drawing Complex Biomolecules ......................................................................................................... 45
    6.4.1 Creating the Structure of β-Maltose ............................................................................................. 45
  6.5 Defining a User Template .................................................................................................................... 47
    6.5.1 The Template.cfg File ................................................................................................................. 47
    6.5.2 Available Templates .................................................................................................................... 48

7. Creating Special Graphical Objects ....................................................................................................... 49
  7.1 Drawing the Energy of Reaction Diagram ............................................................................................ 49
    7.1.1 Drawing a curve: ........................................................................................................................... 49
    7.1.2 Drawing the X and Y axes ............................................................................................................. 50
  7.2 Drawing Different Kinds of Orbitals ..................................................................................................... 51
  7.3 Drawing Vacuum Distillation Apparatus ............................................................................................... 54
7.4 DRAWING A TWO-CHAIN DNA STRAND ....................................................................................56
7.5 DRAWING LIPIDS AND MICELLES ..............................................................................................60
  7.5.1 Drawing the lipid.............................................................................................................60
7.6 CREATING A POSTER ...............................................................................................................62
8. CALCULATING MACROSCOPIC PROPERTIES ...........................................................................64
  8.1 OVERVIEW ..........................................................................................................................64
  8.2 CALCULATING MACROSCOPIC PROPERTIES ......................................................................65
  8.2.1 Menu Command .............................................................................................................65
  8.2.2 Automatic Display on Status Line ...................................................................................66
  8.3 ALGORITHMS FOR CALCULATING MACROSCOPIC PROPERTIES .....................................67
  8.3.1 Molar Volume, MV ..........................................................................................................67
  8.3.2 Molar Refractivity, MR ....................................................................................................67
  8.3.3 Parachor, P_r ....................................................................................................................68
  8.3.4 Density, d .......................................................................................................................68
  8.3.5 Refractive Index, n .........................................................................................................68
  8.3.6 Surface Tension, \( \gamma \) ................................................................................................68
  8.3.7 Dielectric Constant, \( \varepsilon \) (Permittivity) ............................................................................68
  8.3.8 Polarizability ...................................................................................................................68
  8.4 CORRELATION STATISTICS WITH EXPERIMENTAL DATA ....................................................69
  8.4.1 Distribution of Molar Refractivity Prediction Error ...........................................................69
  8.4.2 Distribution of Molar Volume Prediction Error ..................................................................70
  8.4.3 Distribution of the Parachor Prediction Error ..................................................................71
  8.4.4 Distribution of the Refractive Index Prediction Error ......................................................72
  8.4.5 Distribution of the Density Prediction Error ....................................................................73
  8.4.6 Distribution of the Surface Tension Prediction Error ......................................................74
  8.4.7 Distribution of the Dielectric Constant (Permittivity) Estimation Error ............................75
9. SPECIAL FUNCTION KEYS ......................................................................................................76
  9.1 TAUTOMERS .......................................................................................................................76
  9.2 DICTIONARY .......................................................................................................................77
10. GOODIES ..................................................................................................................................78
1. Introduction

1.1 What is ACD/ChemSketch

ACD/ChemSketch is a chemical drawing software package from Advanced Chemistry Development Inc designed to be used alone or integrated with other applications. ChemSketch is used to draw chemical structures, reactions and schematic diagrams. It can also be used to design chemistry-related reports and presentations.

ACD/ChemSketch has the following major capabilities:

- **Structure Mode** for drawing chemical structures and calculating their properties.
- **Draw Mode** for text and graphics processing.
- **Molecular Properties** calculations for automatic estimation of:
  * molecular weight;
  * percentage composition;
  * molar refractivity;
  * molar volume;
  * parachor;
  * index of refraction;
  * surface tension;
  * density;
  * dielectric constant; and
  * polarizability.

ACD/ChemSketch can stand alone as a drawing package or act as the “front end” to other ACD software such as the NMR Predictor engines.

There are additional ACD software items which are accessible through the ChemSketch interface, as single-click buttons. These items, which are increasing in number with each upgrade, are available as additional options and should be considered as separate items. Please contact us for more details on pricing and availability.

- **ACD/Tautomers** - checks and generates the most reasonable tautomeric forms of organic structures (included in freeware and commercial versions)
- **ACD/Dictionary** with over 48,000 systematic and non-systematic names of the most frequently used chemicals and biologicals. The entries cover more than 200 therapeutic areas. The names and structures for inhibitors of more than 500 different enzymes are also available (included in commercial version only)
- **ACD/pKa Predictor** - calculates accurate acid-base ionization constants at 25°C and zero ionic strength for compounds with specified structure (must be purchased in addition to ACD/ChemSketch)
- **ACD/LogP Predictor** - calculates octanol-water partition coefficients (log P values) for neutral molecule (must be purchased in addition to ACD/ChemSketch)
• **ACD/Boiling Point and Vaporization** - calculates accurate boiling points at any pressure from 0.001 mm Hg to 10 atm, in most cases to +/- 10 degrees or better (must be purchased in addition to ACD/ChemSketch)

• **ACD/Solubility** - calculates the solubility of the sketched-in structure as a function of pH (must be purchased in addition to ACD/ChemSketch)

• **ACD/Sigma** - displays the Hammett-type or related parameters for different substituent groups (must be purchased in addition to ACD/ChemSketch)

### 1.2 What’s New

If you are new to this software, we recommend that you work through the examples described in the following chapters. If, however, you have purchased (or are thinking of purchasing) this software to upgrade software you already own, you are likely already familiar with the basic features of ChemSketch. In this section we list only the newest features, and how to quickly access them.

If you have used a previous version of ChemSketch, you will notice major differences between versions 1.0 and 3.5. By contrast, the differences between version 2.5 and 3.5 are more subtle, and some are transparent to the user.

#### 1.2.1 Version 3.5 → 4.0

- Now on the Atoms toolbar (left-hand side) you can find new tools for drawing radicals and ion-radicals quickly and easily:

  ![Radical](image)
  ![Radical Cation](image)
  ![Radical Anion](image)

- Long File Names are supported.

- Improved integration with ISIS Add-in (must be purchased additionally): it is now possible to paste structures from ISIS/Draw and ISIS/Base interface directly into ChemSketch by a single mouse click.

#### 1.2.2 Version 2.5 → 3.5

##### 1.2.2.1 Full Integration with Other Software

ACD/ChemSketch 3.5 is designed to operate with “knowledge” of other applications. It is crucial to upgrade to version 3.5 if any of the following functionality is required:

- a ChemSketch interface to version 3.5 of other ACD software such as HNMR Predictor, pKa DB, SpecManager, etc.;
• use of special “calculator” buttons such as ACD/Solubility, ACD/Boiling Point etc.; OR
• integration with the MDL software packages ISIS/Draw or ISIS/Base via the Add-in Manager.

1.2.2.2 New Features in the ChemSketch Interface

Apart from the “transparent” integration functionality listed above, an upgrade to ChemSketch 3.5 includes the following features:

• ability to set user printing defaults in Page Set-up Dialog;
• isotopic labeling of atoms;
• clear atom numbering command;
• auto re-numbering command;
• R-label button for designating general radicals has been expanded to include 6 radicals now;
• increment and decrement charge buttons;
• atom properties button more accessible;
• more powerful atom properties designation;
• easy-to-access manual numbering;
• ability to read new MOL file format;
• ability to change the color of the page; and
• molecular properties such as index of refraction, molar volume, estimated density are approximated for compounds containing second- and third-row elements.

1.3 About this Guide

To start using ACD/ChemSketch in its full power you don’t have to read a manual, it is so intuitive and simple to use. That’s why this guide doesn’t provide comprehensive descriptions of all the options available in the program; rather, it just gets you started. The exercises in this Guide are designed to take an average of 10 to 60 minutes, depending on whether you decide to work through “Advanced techniques.” After reviewing these exercises, you will be able to use ACD/ChemSketch yourself, without any further assistance and with maximum speed and efficiency.

You will be able to view nearly every section of this manual in animated form in the LotusCam®-based movies, downloadable from our web site as of Winter 1998. (These movies are also present on our demo CD as well as the installation CD.)

Note:
• This User’s Guide is provided in electronic form, readable with a commonly-available word processing program. If you cannot locate an index topic you need, please do a text string-search in the word processing program for the relevant word or phrase, or related words.
• The screen-shots shown throughout this tutorial have been taken with a relatively small window size. The default display is a window which fills the screen. Click once on the Minimize button (upper right-hand corner of window display) to get a smaller working area; click on the Maximize button to return to full-screen display.
• The screen-shots have been taken with the next-to-last version of the software. We have made every effort to match what you will see in ACD/ChemSketch with what the tutorial shows, but there may be slight discrepancies.

• This Guide assumes you have basic familiarity with mouse and file manipulation in Microsoft Windows.

1.4 Useful Definitions

In this tutorial the following terms are used to describe various actions:

♦ **Point** means move the mouse pointer to an item.

♦ **Click** or **left-click** means move the mouse pointer to an item, and press the left mouse button.

♦ **Right-click** means move the mouse pointer to an item, and press the right mouse button.

♦ **Double click** means move the mouse pointer to an item, and quickly press the left mouse button twice.

♦ **Drag** means press and hold down the left mouse button while you move the mouse.

**Note:**

• In Windows the default mouse button side is on the left. You can change the default side to the right by summoning the **Mouse** dialog box from the **Windows Control Panel**. (This also permits you to change the speed and motion attributes of the mouse.)

1.5 Demo Versions

When the demo version is first loaded to run, you will see a message displayed that informs you this is ACD Demonstration software. You may also see this message displayed from time to time throughout the normal course of using the demo software.

Demo versions of ACD/Labs programs have **some command restrictions** such as Save, Copy, Cut, Paste and Print features. If you try to carry out a restricted operation from a demo version, a dialog box will appear which informs you that it is not permitted.

If you would like to know more about a specific restriction in the full version of the program, please contact us. Nevertheless, most of the exercises and examples in this guide are designed so that you can execute them with the demo version of this ACD/Labs program as well.
1.6 Freeware Version

As of the middle of July 1999, Advanced Chemistry Development made ChemSketch 4.0 available as freeware, through the “Free Stuff” link at our web site. Please be advised that the freeware version:

(a) does not come with ACD/Dictionary;
(b) does not include ACD Add-ins for ISIS/Base or ISIS/Draw; and
(c) does not entitle you to technical support.

The freeware ChemSketch

(a) does come with ACD/Tautomers and ACD/3d Optimize;
(b) does include a 15-second sequence listing our other products when it is first started up; and
(c) should be installed to its own separate folder (without any other ACD software).

1.7 For More Information…

To see the latest in ACD software and services, please visit our web-site at


Our web-site is being accessed at the rate of tens of thousands of “hits” per day. There’s a reason for this: much is offered through our web-site. As of Spring 1999, we offer free ChemSketch 3.5, a free ISIS 3D Add-in, free ChemDraw extensions and economical “Interactive Lab” sessions where you can run test calculations using Java applets without purchasing software. There are Lotus Cam-based movies which show the operation of many of our software packages available for download.

We are constantly updating the information on our web-site. The web-site will tell you at which scientific conferences you can visit the ACD booth. You can browse the Frequently Asked Questions page or drop in and “chat” on our newsgroup, which can also be reached via our web page.

If you would like to stay informed of the latest developments in chemical naming software products at ACD, please be sure to sign up for e-mail broadcasts at our web site page:

http://www.acdlabs.com/feedback/mailing.html

1.7.1 How to Get Hold of Us

We are accessible through our web-site, phone, fax and regular mail, but by far the most popular way to contact us is via electronic mail. Questions on pricing, sales, availability and general issues should be directed to

info@acdlabs.com.

Technical and scientific support issues should be addressed to

support@acdlabs.com.

Please tell us the name of the software owner, the version number and release date of the product you are contacting us about. (This information is available by selecting Help/About.) If applicable, please tell us the name of the distributor from whom you purchased the software.
2. Basics of ACD/ChemSketch

2.1 Objectives

This Chapter will familiarize you with

• the computer requirements for running ACD/ChemSketch;

• installation of the software; and

• how to start the program.

2.2 System Requirements

To install and use ACD/ChemSketch, you need the following:

♦ a licensed full-featured version of ACD/ChemSketch, or a demonstration version of ACD/Labs;

♦ an 80486-based IBM PC or compatible (Pentium recommended);

♦ a VGA color monitor;

♦ 12.5 Mb disk space for installation of the licensed full-featured version (estimate includes Dictionary; about 5 Mb disk space without Dictionary);

♦ a Microsoft mouse or fully compatible pointing device;

♦ an operating system: Microsoft Windows 95/98, Windows NT 3.51 OR Windows NT 4.0;

♦ 8 Mb or more of random-access memory (RAM) (16 RAM recommended).

2.3 Starting ACD/ChemSketch

Once ACD/ChemSketch has been installed on your computer, follow these basic steps to start it:

1. Start Windows.

2. Double click on the ACD/ChemSketch icon to start ACD/ChemSketch.

   OR choose the ACD/ChemSketch icon from the Start/Run menu in the Windows 95 or NT Taskbar

   OR double click on the program file “chemsk.exe” in the ACD folder.

You will see the splash screen appear, followed by the ChemSketch window:
3. If this is the freeware version, you will see a 15-second list of ACD products scroll by. Be patient and click Cancel when it becomes active.

4. Then you will see a Tip of the Day box, which you can close after reading.

### 2.4 Exiting ACD/ChemSketch

Once the ChemSketch Window appears, you can exit from the program at any time by selecting Exit from the File menu. If you have begun to sketch structures, you will be prompted to save your work: Yes or No. If you select “Cancel”, ChemSketch will stop its shut-down procedure and you can return to work in the sketch pad area as before.
3. Drawing Simple Structures

3.1 Structure Mode and Draw Mode

In the ChemSketch Window, there are two modes, Structure and Draw:

ACD/ChemSketch allows you to draw chemical structures when the **Structure Mode** button is selected.

When the **Draw** button is selected, ACD/ChemSketch provides the tools for creating posters, reports and reaction schemes.

Generally a user will create the chemical structure in **Structure Mode**, then insert the text, arrows and graphical images while in **Draw Mode**. Both **Structure** and **Draw** modes have the **General** toolbar along the top of the screen, and the **Status line** and **Color Palette** situated at the bottom of the screen. In **Structure** mode, the **Structure** toolbar, complete with tools for editing molecular structures, appears below the **General** toolbar. The **Structure** mode also has an **Atoms** and **References** toolbar displayed vertically down the left and right of the window respectively. When you switch from **Structure** mode to **Draw** mode, the set of tools changes.
Note:

- When you select a new element from the Periodic Table of Elements, corresponding button is automatically added to the Atoms toolbar. To remove this button from the Atoms toolbar double click on it.

- The **Boiling Point** button plus several related buttons are links to other ACD software. This software is included with the ChemSketch demo, but some items are sold separately as add-on products to ChemSketch. They are described in more detail in the last chapter of this manual and in their separate tutorials.

- When ACD/ChemSketch starts up, you will find many menu commands and toolbar buttons dimmed (inactive). They will be enabled as soon as you draw a structure.

- The ChemSketch Window also appears when any other ACD/Labs programs are loaded. It is the common input interface to almost all the ACD software. However this window is slightly different in these ACD/Labs programs. The difference is in the number and type of window switching buttons at the bottom of the screen—and of course, the “engines” which do the calculations.

- To change the properties of the structure you have created (i.e. create a thicker bond line or increase the font size of an atom), simply click on the Select/Move button and then double click on any portion of the structure to bring up the Properties panel. Any changes will affect only the selected portion of the structure. To make global changes to the entire structure, ensure the entire structure has been selected.

- If you make an error during the exercises, click on the **Undo** button (General toolbar) to cancel the change.
  
  To revoke the Undo command, click on the **Redo** button (General toolbar).

- If a drawn structure(s) is not completely visible on the screen, click on one of the **Fit Screen** buttons: Actual size, Full Page, Fit All and Fit selected, in the General toolbar to reposition the structure(s) on the screen.

- To zoom in on a drawn structure, click on the **Zoom In** button (General toolbar) then click on the screen. To zoom out, click on the **Zoom Out** button (General toolbar).

- To clear a screen, you can use the Delete button repeatedly, or you can click on the New Page button. The latter is faster, but you will accumulate more pages in the Sketch file, as shown by the Status line at the bottom of your ChemSketch Window:

| NONAME00.SK2 | Modified | Page 14/16 | Fragments: 1 | C6H12 | P: 240.2±4.0 cm3 | Parachor |

Thus, when printing, always verify whether you have selected Current page or Whole document.
3.2 Using the Draw Normal Tool

The Draw Normal tool is the default tool when the program is started. In this mode you can easily draw normal or branched chains and replace the drawn atoms with other atoms from the Periodic Table of Elements.

1. Make sure that the Draw Normal tool is enabled and that the Carbon atom is selected. If they are not, click on the Draw Normal button on the Structure toolbar and click on the Carbon button on the Atoms toolbar.

2. Click once on an empty space to draw CH₄

3. Click on CH₄ to add a -CH₃ group, creating CH₃-CH₃ with a standard bond length. Click twice on the same Carbon to draw CH₃CH₃

4. Click on the Set Bond Vertically button on the Structure toolbar and click on any bond of the structure to rotate it to this orientation: CH₃CH₃

5. Click on the Draw Normal button on the Structure toolbar.

6. Click on the right-most Carbon atom to draw

7. Repeat the above step to draw the following structures:
8. Click on the **Periodic Table** button on the Atoms toolbar to open the **Periodic Table of Elements**:

<table>
<thead>
<tr>
<th>H</th>
<th>He</th>
<th>Li</th>
<th>Be</th>
<th>B</th>
<th>C</th>
<th>N</th>
<th>O</th>
<th>F</th>
<th>Ne</th>
</tr>
</thead>
<tbody>
<tr>
<td>Na</td>
<td>Mg</td>
<td>Al</td>
<td>Si</td>
<td>P</td>
<td>S</td>
<td>Cl</td>
<td>Ar</td>
<td></td>
<td></td>
</tr>
<tr>
<td>K</td>
<td>Ca</td>
<td>Sc</td>
<td>Ti</td>
<td>V</td>
<td>Cr</td>
<td>Mn</td>
<td>Fe</td>
<td>Co</td>
<td>Ni</td>
</tr>
<tr>
<td>Cu</td>
<td>Zn</td>
<td>Ga</td>
<td>Ge</td>
<td>As</td>
<td>Se</td>
<td>Br</td>
<td>Kr</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rb</td>
<td>Sr</td>
<td>Y</td>
<td>Zr</td>
<td>Nb</td>
<td>Mo</td>
<td>Tc</td>
<td>Ru</td>
<td>Rh</td>
<td>Pd</td>
</tr>
<tr>
<td>Ag</td>
<td>Cd</td>
<td>In</td>
<td>Sn</td>
<td>Sb</td>
<td>Te</td>
<td>I</td>
<td>Xe</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cs</td>
<td>Ba</td>
<td>Hf</td>
<td>Ta</td>
<td>W</td>
<td>Re</td>
<td>Os</td>
<td>Ir</td>
<td>Pt</td>
<td>Au</td>
</tr>
<tr>
<td>Hg</td>
<td>Tl</td>
<td>Pb</td>
<td>Bi</td>
<td>Po</td>
<td>At</td>
<td>Rn</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>La</td>
<td>Ce</td>
<td>Pr</td>
<td>Nd</td>
<td>Pm</td>
<td>Sm</td>
<td>Eu</td>
<td>Gd</td>
<td>Tb</td>
<td>Dy</td>
</tr>
<tr>
<td>Ho</td>
<td>Er</td>
<td>Tm</td>
<td>Yb</td>
<td>Lu</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ac</td>
<td>Th</td>
<td>Pa</td>
<td>U</td>
<td>Np</td>
<td>Pu</td>
<td>Am</td>
<td>Cm</td>
<td>Bk</td>
<td>Cf</td>
</tr>
<tr>
<td>Es</td>
<td>Fm</td>
<td>Md</td>
<td>No</td>
<td>Lr</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Move mouse pointer to any element to view its properties. Click on any element to select it for drawing structures.

9. Click on the **Fluorine** button on the Periodic Table of Elements. Note that the **Fluorine** button is added to the Atoms toolbar.

10. Click on the left-most Carbon to replace it with a Fluorine atom:

   ![Drawing of a molecule with Fluorine replacing the Carbon]

   **Note:**
   - When you select new elements from the **Periodic Table of Elements**, corresponding buttons are automatically added to the Atoms toolbar. To remove these buttons from the Atoms toolbar, double click on any of them or double click on the Atoms toolbar and choose **Yes**.

### 3.3 Using the Draw Continuous Tool

When the Draw Continuous tool is active, bonds can only be drawn from the highlighted atom. To highlight an atom, click on it. This mode is very convenient for "sprouting" new atoms from a selected atom.

1. Click on the **Draw Continuous** button on the Structure toolbar. Alternatively, you can press the right mouse button to switch to this drawing mode.
2. Make sure that Note that the Fluorine button \( F \) is selected on Atoms toolbar.

3. Click on the right-most carbon in the drawn structure to select it. Click the second time to sprout fluorine from the selected carbon. Click twice on the same carbon again to sprout the second fluorine atom:

\[
\begin{align*}
\text{CH}_3 & \quad \text{F} \\
\text{F} & \quad \text{F} \\
\text{F} & \quad \text{F}
\end{align*}
\]

### 3.4 Using Mouse Drag

With both drawing tools, Draw Normal and Draw Continuous, dragging the mouse from one atom to another draws a single bond between them. If you drag to or from an empty space, a new atom is inserted at the start or at the end of the drawn bond. The Draw Chains tool does not create bonds between two atoms.

1. Point the mouse arrow to one of the terminal carbons and drag to another terminal carbon to draw the following structure:

\[
\begin{align*}
\text{F} & \quad \text{F} \\
\text{F} & \quad \text{F}
\end{align*}
\]

### 3.5 Using the “Clean” Command

2. Click the Clean button \( \text{Clean} \) on the Structure toolbar to standardize all the bond lengths and angles in the drawn structure to obtain the following:

\[
\begin{align*}
\text{F} & \quad \text{F} \\
\text{F} & \quad \text{F}
\end{align*}
\]

**Note:**

- The Clean command not only standardizes all bond lengths and angles to make the structure look nice — it makes the drawn structures closer to being chemically correct. For acyclic fragments, for example, it places the bonds near the \( sp^3 \) carbons at 120° angles and the bonds near the \( sp \) carbon at 180° (linear). If you draw geometrical and stereo isomers, the “Clean” command standardizes their bond lengths and angles while retaining all of their structural significance.

### 3.6 Using the Stereo, Coordinating and Undefined Bond Tools

You can draw a wide variety of bonds, besides the “ordinary” connection:

- stereo bonds directed away from you \( \text{Stereo} \)
- stereo bonds directed towards you \( \text{Stereo} \)
• coordinating bonds \[ \text{\textbullet} \]  
• and undefined bonds \[ \text{\textbullet} \]

Select any of these tools and click on any bond in the drawn structure. Click repeatedly on a stereo or coordinating bond to change its direction.

### 3.7 Editing Atom Labels

The **Edit Atom Label** tool \[ \text{\textbullet} \] allows you to substitute terminal atoms with shorthand abbreviations.

1. Click on the \[ \text{\textbullet} \] button on the Atoms toolbar and then on the right-most fluorine atom in the drawn structure.

2. In the open **Edit Label** dialog box type in \((\text{CH}_2)_3\text{Ph}\) and click on the **Insert** button. The following structure is drawn:

3. With the active Edit Atom Label tool click on the obtained shorthand abbreviation to open the Edit Label dialog box again. Then click on the **Expand** button to obtain the following structure:

### 3.8 Inserting Labels and Using the Expand Option in Structure Drawing

To create the structure \((\text{OH})_2\text{SCl}_2\) do the following:

1. Switch to the **Structure** mode and choose **Cyclohexane** \[ \text{\textbullet} \] from the **Table of Radicals**. Click on the workspace to copy the chosen template to the sketchpad area.

2. Select the **Edit Atom Label** tool \[ \text{\textbullet} \] from the Atoms (left) toolbar and click on the indicated atom.
3. In the Edit Label dialog type (OH)2SCl2 and click [Insert]. Note that the label is inserted in the desired position and the indexes are automatically subscripted:

\[ \text{Cl}_2\text{S(}\text{HO}\text{)}_2 \]

4. Select the Change Position tool \[ \text{Change Position tool} \] and click on the label to invert it:

\[ (\text{OH})_2\text{SCl}_2 \]

5. Next click on the label three times while holding down the Shift key to change the connection point of the label:

\[ (\text{OH})_2\text{SCl}_2 \]

6. Select the Set Bond Horizontally tool \[ \text{Set Bond Horizontally tool} \] on the Structure toolbar and click on the indicated bond to change the orientation of the structure:

\[ (\text{OH})_2\text{SCl}_2 \]

### 3.9 Using the Draw Chains Tool

Using the Draw Chains tool, you can easily draw short or long chains with a single click and mouse drag.

1. Click on the Draw Chains button \[ \text{Draw Chains} \] on the Structure toolbar and point the mouse arrow to the atom indicated by the arrow:
2. Press mouse button and drag to the left side. As you move the mouse away from the structure, a carbon chain is created. Note the carbon counter (C #) located beside the mouse arrow changes with each carbon added or removed. Continue until the counter reaches C 8, then release the mouse button to finish the chain:

![Carbon Chain](image)

3. With the active Draw Chains tool select the **Fluorine** button on the Atoms toolbar and click on the left-most carbon to sprout three fluorine atoms. Then click on the **Clean** button on the Structure toolbar to obtain the following structure:

![Fluorine Structure](image)

### 3.10 Flipping Structures

You can rotate or flip the structure(s) by using the following buttons:

- **Set Bond Horizontally**
- **Set Bond Vertically**
- **Flip on Bond**
- **Flip Top to Bottom**
- **Flip Left to Right**

To use **Flip Top to Bottom** or **Flip Left to Right**, select the desired structure or fragment then click on the button.

To **Set Bond Horizontally** or **Vertically** or to **Flip on Bond**, select the appropriate button then click on the bond around which rotation or flipping is required.
3.11 Selecting, Rotating, and 3D Rotating

You can select atoms, bonds and fragments in two different ways, by using the button which toggles between

- the Lasso Selector or
- the Rectangle Selector.

Once the fragment(s) has been selected, there are three ways you can move it:

- Move,
- Rotate/Re-size,
- 3D Rotate,

or you can perform one or more other operations on it:

- Delete,
- 3D Optimization or
- 2D Optimization (or Clean).

3.12 Clearing the Screen

To clear the screen, you can do one of the following:

♦ Choose the New command from the File menu to open a new document.

♦ Choose the New Page button from the upper left set of buttons to go to a new page.

♦ Choose the Select All command from the Edit menu and then choose the Delete command.

♦ Click on the Delete button on the General toolbar. Click once on an empty space away from the drawn structure to select all of the structures, then click on any structure to delete the entire screen.

Note:

♦ In Structure Mode only chemical structures can be selected and then deleted by this way. To clear the graphic objects switch to Draw Mode.
4. Drawing More Complex Structures

4.1 Using the Table of Radicals

The Table of Radicals includes pre-drawn structures of amino acids, their protecting groups, as well as nucleotides and other frequently used radicals.

1. Clear the screen using the directions given in previous section.

2. Click on the Table of Radicals button on the References toolbar to display the radicals:

3. Click on the Cyclohexane button on the Table of Radicals.

4. A Cyclohexane button is now located and currently selected on the References toolbar on the right side of the screen.

5. Repeat these steps for the Cyclopentane button.
4.2 Using Ring Structures

1. Select the cyclopentane button on the References toolbar on the right side. Click on the screen to create a five-membered ring.

2. On the same toolbar, select the icon. Now point the mouse arrow to highlight the indicated bond, and click to create the following structure:

3. Repeat these steps to create the following structure:

4. Click on the Set Bond Vertically button then click on the indicated bond to rotate the structure around this bond to obtain the following:

5. Click on the Table of Radicals button on the References toolbar.

6. In the Table of Radicals window, select the carboxyl group by clicking on the button.

7. Click on the atoms indicated to sprout carboxyl groups from them:
4.3 Deleting Atoms and Fragments

Delete the atoms indicated by arrows in

You can do this in two ways: delete each atom individually or delete all atoms simultaneously.

4.3.1 Deleting atoms individually:
1. Click on the Delete button.
2. Click on each of the atoms which you want to delete.

4.3.2 Deleting all the atoms simultaneously
1. Click on the Lasso On/Off button on the Structure toolbar to enable the Lasso selection mode. Note the Select/Move tool becomes active.
2. Drag to include all of the specified atoms in the closed Lasso line:
3. Click on the Delete button on the General toolbar.
4. Click on any of the highlighted atoms to delete all of them simultaneously.

Note:
- You can select atoms, bonds and fragments in two different ways, by using either the Lasso selector or the Rectangle selector. To deselect fragment(s), click anywhere on an empty space.

4.4 Replacing Atoms

Replace the atoms indicated with arrows in

1. Click on the Nitrogen button on the Atoms toolbar and then click on all the Carbons denoted by an open-head arrow on the above structure.
2. Click on the **Oxygen** button on the Atoms toolbar and then click on three Carbons denoted by a solid-head arrow.

**Note:**
- You cannot replace atoms with the Draw Continuous tool (see Section 3.3).

### 4.5 Setting Double and Triple Bonds

1. Click on the bonds indicated in the structure to set double bonds:

   ![Structure with double bonds](image)

2. Using the Change Double Bond or Hydrogen Position button, the structure’s appearance can be “fine-tuned”. Select this button and click on the indicated hydrogens and double bonds. Note the movement of hydrogen around the nitrogen and oxygen, and the double bond around the single bond:

   ![Structure with fine-tuned bonds](image)

**Note:**
- You can set a double or triple bond or reset a single bond by repetitive clicking on a chosen bond. This will cycle through all bond orders available. When an atom has an invalid number of bonds, a corresponding charge is placed on it and it is crossed out with a red “X”:

   ![Invalid bond](image)

- If you want to disable the crossing-out function, choose **Structure, Properties** from the **Tools** menu and un-mark the **Cross Out Invalid Atom** check-box in the **Properties** panel.
4.6 Setting Charges

Set a negative charge on the oxygen indicated by an arrow:

1. Click on the Decrement Charge button on the Atoms toolbar and then click on the indicated oxygen:

Note:
- When you use the Charge buttons, + or −, to change the charge of a non-metal, the corresponding number of hydrogen atoms is automatically added to it, or removed from it, to preserve proper chemical valency. If you change the charge of a metal, the charge is changed in increments or decrements in accordance with the next chemically valid charge of the corresponding ion. (You can view common valences used in the Periodic Table of the Elements button; choose the atom of interest.)
4.7 Displaying Atom Properties

If you want to display the valency or the isotopic mass of the atom in a ChemSketch structure—or even change the typeface or the size of the Atom, you will want to Edit atom properties.

1. To do this, just click once on the Select/Move button.

2. Then double-click on the atom whose displayed properties you want to change. (Or you can Edit/Select All of the molecule.) This will make the Properties dialog box appear:

The seven buttons when clicked in turn, permit you to change settings for

- C – atom symbol
- H – attendant hydrogens
- n – index of the attendant hydrogens
- q – charge
- V – valence
- I – isotopic mass
- N – numbering of atom in the overall molecule.

Once you set the values, whether they are shown, and so forth, then click on Apply to have the change appear immediately on the molecule.
5. Advanced Structures

The Clean option can be considered to be a 2D-optimization of the drawn structure, i.e. re-drawing and re-sizing it to standardize all the bond lengths and angles. Using this option you can easily draw a structure perfectly. Some examples:

5.1 2D Optimization

5.1.1 Creating the Structure of Cyclic Alkanes

This section is based on the movie cycloalk.exe which can be downloaded from our web site or found in the Movies folder.

Using the following technique you can quickly draw cyclic alkanes perfectly. Here's how to draw Cyclononane:

1. Switch to the mode and delete any previously drawn structures by pressing Ctrl + A and Del.

2. Choose the Draw Chains tool and drag in the workspace to draw a 9-member chain. Note that the informative cursor shows the number of atoms in the chain.

3. Click on the right mouse button to quickly switch to the Draw Normal tool and drag from one end atom to another in order to connect them with a bond.

4. Click on the Clean Structure button to obtain the following structure:

Try to draw C_{10} and C_{8}-rings using the above technique.
5.1.2 Creating the Structure of a Cyclic Peptide

This section is based on the movie pept.exe which can be downloaded from our web site or found in the Movies folder.

Let’s draw the cyclic Tyr-Ala-Trp. Again we will find the Clean Structure button is useful.

Switch to the **Structure** mode and delete any previously drawn structures by pressing Ctrl + A and Del.

1. From the Template Window choose the **Amino Acids** tab.
2. From the set of amino acids, choose Tyrosine and click in the workspace to copy the structure.
3. From the Table of Radicals choose Alanine and then Tryptophan and click on the indicated atoms to attach the corresponding radicals:

   ![Diagram of Tyr-Ala-Trp structure]

   **Note:**
   - You can flip the template shadow before fixing it by pressing the Tab key.
4. Click the right mouse button to quickly switch to the Select/Move tool and drag the NH2 group to the OH group as shown:
5. Click on the Clean Structure button to obtain the following structure:

![Structure Image]

Try to draw any other cyclic peptide, for instance Gramicidin S:

```
Phe ← Leu ← Orn ← Val

↓

Pro

↓

Val → Orn → Leu → Phe
```

### 5.2 3D Optimization

This Chapter explains how to create structures that have nonstandard angles and bond lengths. There is no need to explain how difficult it is to draw such molecules proportionally. The 3D-Optimization and 3D Rotation options will help you to quickly cope with this task. These options make it possible to create complex structures in ACD/ChemSketch with ease.

The 3D optimization algorithm is a proprietary version of molecular mechanics with the force field initially based on CHARMM parameterization\(^1\). The modifications involve some simplification and were intended to increase the stability and speed of computation. Note that 3D-optimizer is NOT a full-scale molecular mechanics engine. Its design aims to reliably reproduce reasonable conformations from (possibly very unreasonable) 2D drawings, rather than to precisely optimize 3D structures.

If 3D-optimizer produces the conformation different from what you have expected, do not be surprised. It is the very essence of conformational analysis that molecules typically have many conformations. The optimizer finds only one, and it should not be one you have expected. For example, you probably expect a cyclohexane fragment to be a chair, but the optimizer may generate twist-boat, which is also one of its suitable conformations (indeed, in many structures this fragment exists in a twisted form). In such a case, you may try to correct the conformation (e.g., by manually moving the atoms into desired direction and 3D-optimizing the structure again).

You may wish to perform actual conformational analysis of your molecule using a special molecular mechanics or quantum chemistry geometry optimization package. ChemSketch 3D-optimized structure will serve as input data.

**Important:** Prior to starting any of the exercises in this section, unmark the Add Hydrogens check box in the Structure Tab in the Preferences Dialog Box (Options Menu).

---

5.2.1 Creating the Structure of Bicyclo[2.2.2]octane

This section is based on the movie bicyc.exe which can be downloaded from our web site or found in the Movies folder.

Switch to the Structure mode and delete any previously drawn structures by pressing Ctrl + A and Del.

1. From the Table of Radicals choose Cyclohexane. Click in the workspace to place a cyclohexane ring.

2. Click on the Draw Normal tool and draw the hydrocarbon bridge by dragging as shown in the following scheme:

3. Click on the 3D Optimization button to obtain a 3D model of the drawn structure.

Note:
- If there is more than one structure in the workspace you should select the structure you want to 3D-optimize using any of the selection tools (Select/Move, Select/Move/Resize or 3D Rotation tools).

4. Switch to the 3D-Rotation tool. Place the mouse cursor over any atom or bond in the structure and drag the mouse over the workspace to rotate the structure until it is placed as shown:

Note:
- If the Switch to 3D Rotation mode check box in the Structure tab of the Preferences dialog box (Options menu) is selected, you will be automatically switched to 3D Rotation mode after the 3D Optimization is complete.
- You can choose whether the background bond should be broken or not by marking or un-marking the Enable bonds intersections check box in the Structure tab of the Preferences dialog box (Options menu).
- You can change the position of intersecting bonds by applying the Bring Bond to Front or Send Bond to Back commands (Options menu) to the selected bond. You can also bring
the background bond to the front by clicking on it with the Change Position tool active while holding down the Shift key.

⚠️ **Try to draw the following structures on your own using the above technique**

- Bicyclo[2.2.1]heptane
- Bicyclo[4.2.1]nonane

### 5.2.2 Creating the Structure of Triptycene

👍 Thumbs up This section is based on the movie **triptyc.exe** which can be downloaded from our website or found in the Movies folder.

Switch to the **Structure** mode and delete any previously drawn structures by pressing `Ctrl + A` and `Del`

1. Draw the structure of **bicyclo[2.2.2]octane** as described above or use the corresponding template from the **Template Window** (the **Bicyclics** tab).

2. From the **Table of Radicals** choose **Benzene**.

3. Position the cursor over the bond **a** and click to attach the benzene ring to this bond:
4. Repeat steps 2--3 for bonds \( b \) and \( c \) to obtain the following structure:

![Structure Image]

5. Click on the **3D Optimization** button to obtain a 3D-model of the drawn structure:

![3D Model Image]

**Note:**

- If there is more than one structure in the workspace you should select the structure you want to 3D-optimize using any of the selection tools (Select/Move, Select/Resize, or 3D Rotation tools).

- Select the **3D Rotation** tool. Place the mouse cursor over any atom or bond of the structure and drag the mouse over the workspace to obtain the projection you want.

- If the Switch to 3D Rotation mode check box in the Structure tab of the Preferences dialog box (Options menu) is selected, the program will automatically switch to 3D Rotation mode after the 3D Optimization is complete.

6. Choose the **Show Aromaticity** command from the **Tools** menu to show the aromatic rings:

![Aromatic Rings Image]
5.2.3 Creating the Structure of Cubane

This section is based on the movie `Pr_cub.exe` which can be downloaded from our web site or found in the Movies folder.

1. Switch to the **Structure** mode and delete any previously drawn structures by pressing `Ctrl + A` and `Del`.

2. From the **Table of Radicals** choose **Cyclobutane**. Click twice in the workspace to place two squares (4-membered rings) one under another.

3. Choose the **Draw Normal** tool and connect the corners of cyclobutane molecules with bonds by dragging from one atom to another as shown:

4. Click on the **3D Optimization** button to obtain the 3D model of the drawn structure.

   **Note:**
   - If there is more than one structure in the workspace you should previously select the structure you want to 3D-optimize using any of the selection tools (Select/Move, Select/Rotate/Re-size or 3D Rotation tools)

5. Select the 3D Rotation tool.

6. Place the mouse cursor over any atom or bond of the structure and drag the mouse over the workspace to obtain the projection you want:

   **Note:**
   - If the Switch to 3D Rotation mode check box in the Structure tab of the Preferences dialog box (Options menu) is selected, the program will automatically switch to 3D Rotation mode after the 3D Optimization is completed.
You can choose whether the background bond should be broken or not by marking or un-marking respectively the Enable bonds intersections check box in the Structure tab of the Preferences dialog box (Options menu).

You can change the position of intersecting bonds by applying the Bring Bond to Front or Send Bond to Back commands (Options menu) to the selected bond. You can also bring the background bond to front by clicking on it with the Change Position tool active while holding down the Shift key.

Try to draw the following structures on your own using the above technique

Prismane

Hexacyclo[4.2.0.0²,5.0³,9.0⁴,8.0⁷,10]decane

5.2.4 Creating the Structure of Dodecahedrane ([5]Fullerene-C₂₀)

This section is based on the movie fuller.exe which can be downloaded from our web site or found in the Movies folder.

Switch to the Structure mode and delete any previously drawn structures by pressing Ctrl+A and Del.

1. From the Table of Radicals choose Cyclopentane. Click in the workspace to place a cyclopentane ring.

2. Position the mouse pointer over every bond of the ring and click to attach five other rings:

3. Click the right mouse button to quickly switch to the Select/Move tool.
4. Move by dragging atoms \( a, c, e, g, i \) to atoms \( b, d, f, h, j \) accordingly as shown in the following scheme:

![Diagram showing movement of atoms](image)

5. Select the **Carbon** button \( \text{C} \) on the Atoms (left) toolbar and click directly on the points indicated by arrows:

![Diagram showing selection of carbon atoms](image)

6. Connect the adjacent methyl groups with single bonds by dragging from one terminal atom to another to obtain the following structure:

![Diagram showing connection of methyl groups](image)

7. Click on the **3D Optimization** button to obtain the 3D model of the drawn structure.

**Note:**
- If there is more than one structure in the workspace you should select the structure you want to 3D-optimize using any of the selection tools (Select/Move, Select/Rotate/Resize, or 3D Rotation tools)

8. Select the **3D Rotation** tool \( \text{3D Rotation} \) Place the mouse cursor over any atom or bond in the structure and drag the mouse over the workspace to obtain the projection you want.

![Diagram showing 3D rotation](image)
**Note:**

- If the Switch to 3D Rotation mode check box in the Structure tab of the Preferences dialog box (Options menu) is selected, the program will automatically switch to 3D Rotation mode after the 3D Optimization is complete.

- You can choose whether the background bond should be broken or not by marking or un-marking the Enable bonds intersections check box in the Structure tab of the Preferences dialog box (Options menu).

- You can change the position of intersecting bonds by applying the Bring Bond to Front or Send Bond to Back commands (Options menu) to the selected bond. You can also bring the background bond to front by clicking on it with the Change Position tool active while holding down the Shift key.

⚠️ And now try to draw the following structures using the technique described above

[4,6]Fullerene-C\textsubscript{24}  
[5,6]Fullerene-C\textsubscript{24}
6. Advanced Drawing: Templates

ACD/ChemSketch includes the following 3 sources of structure templates:

- **Table of Radicals**
- **Template Window**
- **Instant Template tool**

While the binding point of any template in the **Table of Radicals** is fixed (invariable), the **Template Window** or the **Instant Template** tool allow you to specify any atom or bond to be the binding point simply by clicking directly on it. However, no matter what the source of template is, the principles of joining are the same. There are several ways of joining the template to a drawn structure:

   - By fusing the bonds of the structure and template: point the mouse pointer over the bond so that the corresponding bonds of the structure and the template shadow are fused and then click.
   - By attaching the template to the structure: point the mouse pointer on the corresponding atom on the structure so that the connecting bond appears and click
   - By drawing a spiro connection between the template and the structure: point the mouse pointer on the atom you want to be the binding point and click holding down the **Shift** key.

**Note:**
- You can flip the template shadow before fixing it by pressing the **Tab** key

ACD/ChemSketch presents a very convenient way for managing template files: both those included with the software package, and those which you decide to create. It will just take you a minute to save your document as a template and then quickly find it. Note that the only difference between the template file and a usual file is the fact that you can find the template file in the Template Window Organizer. Otherwise it is a usual document with the extension *.sk2. By saving files this way there are several advantages:

* Your *.sk2 files scattered over different directories and disks will be gathered in one place (the Template Window Organizer).
* You can assign a name to the template that is more descriptive than what the real file name is. This will better reflect the contents of the document and allow you to quickly find the document you need.
* You can quickly find the document by previewing its contents in the Preview Field of the Template Window.
* You can quickly open a selected document from the list just by clicking the Open Document button in the Template Window Organizer.
* Only 15 templates at any one time can be accessed through the template window.
6.1 Instant Template Tool

A useful ACD/ChemSketch feature is the Instant Template tool [ ] which will help you save time by allowing you to draw fragments quickly. You can think of it as a “replicate” command.

6.1.1 Creating the Structure of a Cyclic Oligomer

This section is based on the movie oligomer.exe which can be downloaded from our web site or found in the Movies folder.

Switch to the [ ] mode and delete any previously drawn structures by pressing Ctrl + A and Del.

1. From the Table of Radicals [ ] choose Benzene [ ]. Point the cursor to the upper middle part of the workspace and click to place a benzene ring.

2. From the Table of Radicals choose Ethynyl [ ] and click on the atom indicated by the arrow to attach it to the ring:

3. Choose the Instant Template tool [ ] and click on the indicated atom to create an instant template
4. Click on the atom indicated by the arrow to attach the template:

5. Choose the **Instant Template** tool again and click on the atom to create the template of the whole fragment:

6. Click on the atoms to attach the template as shown. To hide the template shadow click the right mouse button after you finish drawing:

7. Choose the **Draw Normal** tool and click on the indicated atom to complete the ring:
6.2 Table of Radicals in Structure Drawing

6.2.1 Creating the Structure of Fluorescamine

This section is based on the movie fluor.exe which can be downloaded from our web site or found in the Movies folder.

Switch to the Structure mode and delete any previously drawn structures by pressing Ctrl + A and Del.

1. From the Table of Radicals choose Cyclopentane. Click in the workspace to copy the cyclopentane ring.

2. Click on the indicated atom while holding down the Shift key to obtain the spiro-connection with the second cyclopentane ring.

3. From the Table of Radicals choose Benzene. First click on the indicated bond to fuse the benzene ring and then click on the indicated atom to connect the phenyl radical:
4. Choose the Oxygen \( \text{O} \) button on the Atoms (Left) toolbar (note that the **Draw Normal** tool is automatically enabled). Click on the indicated atoms to replace them with oxygen atoms:

![Diagram showing the changes](image)

5. Click the right mouse button to quickly switch to the **Draw Continuous** tool. Double-click on the indicated atoms to attach the OH groups to them:

![Diagram showing the changes](image)

6. Click on the indicated single bonds to replace them with double-bonds:

![Diagram showing the changes](image)
6.3 Templates from the Template Window

A brief tour of available ChemSketch Templates is given in the movie templ_st.exe which can be downloaded from our web site or found in the Movies folder.

6.3.1 Creating the fragment of a DNA molecule

This section is based on the movie dna_st.exe which can be downloaded from our web site or found in the Movies folder.

Switch to the Structure mode and delete any previously drawn structures by pressing Ctrl + A and Del.

6.3.1.1 Drawing the chain of deoxyriboso-5-phosphate fragments

1. Open the Template Window. From the DNA/RNA Kit tab choose 2-Dioxyriboso-5-phosphate (chain form) by clicking on the indicated atom:

   ![2-Dioxyriboso-5-phosphate](image)

   **Click**

   2-Deoxyriboso-5-phosphate

2. Click in the workspace to copy the chosen template.

3. Position the mouse pointer over the indicated atom and while holding down the Shift key click to attach the next Deoxyriboso-5-phosphate fragment:

   ![Deoxyriboso-5-phosphate Attachment](image)
4. Select the **Select/Rotate/Re-size** tool.

5. Select the indicated part of structure by dragging the selection rectangle around it. Drag the action center onto the oxygen atom indicated by arrow. Then holding down the **Shift** key drag the selected part of structure clockwise to rotate it by 90°:

![Image of molecular structure before and after rotation]

6.3.1.2 Adding the bases

1. Open the **Template Window**. From the **DNA/RNA Kit** tab choose the base you need by clicking on the atom that will be the attachment point.

2. Position the mouse pointer over the indicated atom and click while holding down the **Shift** key:

![Image of adding base to nucleotide]

**Note:**
- You can flip the template shadow before fixing it by pressing the **Tab** key.

3. Repeat step 2 to add bases to other nucleotides:

![Image of adding base to nucleotide]

⚠️ **Now try to draw your own DNA or RNA fragment of any length**
6.4 Drawing Complex Biomolecules

Here are some examples for creating complex biomolecules using different ACD/ChemSketch tools.

6.4.1 Creating the Structure of β-Maltose

This section is based on the movie maltose.exe which can be downloaded from our web site or found in the Movies folder.

Switch to the mode and delete any previously drawn structures by pressing Ctrl + A and Del.

1. Click on the Open Template Window button.

2. Select the tab, and confirm that you are viewing the Haworth formulae page. If not, click on the arrow to the right of the text box and choose accordingly.

3. Click once on α-D-Glucopyranose to select it and click in the workspace to copy it.

4. Repeat steps 1-3 selecting the beta-D-pyranose tab and choose β-D-Glucopyranose

5. Click once in the ChemSketch Window to place it to the right of the first structure.

6. Choose the Carbon button. Click on the indicated atom in the α-D-Glucopyranose structure to replace it with a CH₃ group and then drag from the CH₃ group to the right while holding down the Shift key to draw the bond at a perfect right angle:
7. Repeat step 3 for the β-D-Glucopyranose structure to obtain the following structure:

8. Choose the Oxygen button \( O \) and click on the indicated atom in the β-D-Glucopyranose structure.

9. Choose the Select/Move tool \( \text{Select/Move} \). Click in the workspace adjacent to, but not touching, the β-D-Glucopyranose structure to select it. Place the mouse cursor over any atom or bond of the selected structure and drag it to the left until the corresponding OH and CH\(_3\) groups overlap each other.

Note:
- You can hide single hydrogens in the selected structure by choosing the Remove Hydrogens option from the Tools menu.

- Though the carbon atoms which are bonded to central oxygen are hidden they are still present. If the chemical meaning is important for your task you can remove these atoms in the following way. With the Select/Move tool active double click on the hidden atom. When the Properties panel appears; click on the Atom tab, then on the Atom Symbol button \( \text{C} \) and from the Value pull-down list choose Empty \( \text{Empty} \). Click Apply.

⚠️ **Try drawing the following structure on your own using the technique as described above**
6.5 Defining a User Template

It is very easy to assign a ChemSketch file as a Template. As of Summer 1998, we are offering free Templates that can be downloaded from our web site. To designate a ChemSketch file as a template, we recommend you place the SK2 file in the Templates folder. Then, do the following:

1. Save your current structures as an SK2 file or open the SK2 file (with structures in it) in ChemSketch.
2. From the Templates menu choose the Save User Template command.
3. In the Save User Template dialog box type in the name for your template, such as “Alkaloids”, and browse to obtain the path name to your file, such as “C:\ACD40\Templates\alkaloids.sk2” and click OK.

Note:
- You can enter any name for your document (e.g. for the document b_d_fur.sk2 the following name - Sugars: beta-D-Furanose - would be more appropriate).
- You can create a user template from any document even if it is closed. Open the Template Organizer dialog box (Templates menu), click the New... button, find the needed document and assign it a name.

Once your document is saved as a user template, its name (under the entered name) is automatically added to the list of templates in the Template Organizer and Template Window (Templates menu).

You can perform the following tasks with the user template:
- Quickly find the document and open it for editing. From the Template List (Template Organizer) choose the needed template and click Open Document button.
- Copy any part of your document to the workspace (Structure or Draw mode) without opening the whole document. To do this find your template in the Template List (Template Window) and click on the item to place it into the workspace.

6.5.1 The Template.cfg File

The key to management of the templates in ACD/ChemSketch is the file template.cfg. This file lets ChemSketch know that a .SK2 file is a template file rather than simply a user file. It can be opened and read with any text editor, although you will likely never need to do so. The Template Window accesses “template.cfg” to let it know what files to display as templates. If a .SK2 file is not shown in the Template Window, it will be added to “template.cfg” by when you open the SK2 as a regular ChemSketch file and select the command to save as a user template.

If template.cfg is moved or lost, the Template Window will not display any templates. If the template.cfg file is found (by Windows Explorer, for example, or the system “Find File” utility) it can be restored to the default directory or the user’s private directory. If it cannot be found, it must be retrieved by reinstalling ChemSketch or by adding each template individually as detailed above.
6.5.2 Available Templates

As of Summer 1999, this is the list of templates available for download from our “Free Stuff” section of our Web site:

- Monomer Template 6.22 kb
- Alkaloid Template 31.9 kb
- Steroid Template 7.35 kb
- Terpene Template 12.4 kb
- Tipped Rings Template 1.83 kb
- Solid Phase Synthesis Resins 3.81 kb
- Template for Phosphorus Compounds 2.5 kb
- Template for Carbonyls 3.1 kb
- Newman Projections 6.6 kb
- Lewis Structures 12.2 kb
- Chem Quiz 4.3 kb
7. Creating Special Graphical Objects

7.1 Drawing the Energy of Reaction Diagram

This section is based on the movie `diagram.exe` which can be downloaded from our web site or found in the Movies folder.

Switch to the Draw mode and select the Polyline tool.

7.1.1 Drawing a curve:

1. Drag horizontally to the right from the starting point of the curve to stretch the control line.
2. Release the mouse button.
3. Move the mouse up to draw the first segment of the curve.
4. Drag horizontally to the right to stretch the control lines. By changing the length of the control lines you can modify the form of the curve segment.
5. Release the mouse button.
6. Move the mouse down to draw the next segment.
7. Repeat the above steps to draw the next two segments.
8. Click the right mouse button to finish drawing the curve.

7.1.2 Drawing the X and Y axes

Make sure that the Polyline tool is pressed in.
* Select the Draw Arrow tool. In the Arrow panel from the Arrow Type pull-down list choose the two way arrow.

1. Click at the endpoint of the Y axis.
2. Move the mouse down vertically to draw the axis.
3. Click to fix the point of axis intersection.
4. Move the mouse horizontally to the right to draw the X axis.
5. Click to fix the endpoint of the X axis.
6. Click the right mouse button to finish drawing the axes.

**Note:**

- You can easily draw the axes at a right angle by choosing the Snap on Grid and/or Show Grid command (Options menu).

7. Add inscriptions using the Text and Rotate 90° tools.

Another way to draw axis is to use the Line tool, but in this case you will have to apply the arrow head afterwards by choosing the
7.2 Drawing Different Kinds of Orbitals

This section is based on the movie orbital.exe which can be downloaded from our web site or found in the Movies folder.

Switch to the **Draw** mode.

1. To draw this orbital do the following:
   1. Select the **Polygon** tool.
   2. Drag horizontally to the right from the starting point of the orbital to stretch the control line.
   3. Release the mouse button.
   4. Move the mouse down to draw the body of the orbital.
   5. Click to fix the orbital.
   6. Click the right mouse button twice to finish drawing the orbital and to quickly switch to the **Select/Move/Re-size** tool.
   7. Position the cursor over the selected orbital; while holding down the **Ctrl** key drag it down to make a copy of the drawn orbital.
   8. Choose the **Flip Top to Bottom** button to flip the lower segment of the orbital. Align the segments by moving them.
   9. Point to the gray color button in the **Color Palette** and click on the left mouse button to change the fill color of the orbital segment.
**Notes:**

- To quickly center the orbital segments, select them and click the Center Horizontally button.

- If you select both segments of the orbital and click the Group button, you will be able to manipulate them as a single object, e.g. rotate using the Select/Move/Rotate tool.

II. To draw the orbital do the following:

Select the **Polygon** tool.

1. Drag horizontally to the right from the starting point of the orbital to stretch the control line.
2. Release the mouse button.
3. Move the mouse down to draw the body of the orbital.
4. Drag horizontally to the right to stretch the control lines. Note that to make the two segments of the orbital identical, you must make sure the lengths of the control lines are equal.
5. Release the mouse button.

**Note:**

- You can easily draw the symmetrical orbital by choosing the Snap on Grid command (Options menu).

6. Click the right mouse button to finish drawing the orbital and to switch to the Select/Move/Resize tool.
7. Select the orbital and hold down the Ctrl key drag to make a copy of it.

8. Choose the Rotate 90° button to rotate the copy of the orbital.
9. Move the copy by dragging it.
10. Point to the gray color button in the Color Palette and click on the left mouse button to change the color of the orbital.

![Diagram showing the steps to create a special graphical object]

**Note:**
- To quickly center the orbitals, select them and click the Center Horizontally button.
- If you select both orbitals and click the Group button, you will be able to manipulate them as a single object, e.g. rotate using the Select/Move/Rotate tool.

### III. To draw this orbital do the following:

1. Select the Ellipse tool and drag in the workspace to draw an ellipse.
2. From the Objects menu choose the Convert to Polyline command.
3. Select the Edit Nodes tool.
4. Drag the lowest node up.

![Diagram showing the steps to create an orbital]

Click the right mouse button to switch to the Select/Move/Re-size tool.

5. Select the orbital by clicking on its contour and holding down the Ctrl key drag to make a copy of it.

6. Choose the Flip Top to Bottom button to flip the lower orbital.

7. Point to the gray color button in the Color Palette and click on the left mouse button to change the color of the orbital.
Note:

- To quickly center the orbitals, select them and click the Center Horizontally button.
- If you select both orbitals and click the Group button, you will be able to manipulate them as a single object.

7.3 Drawing Vacuum Distillation Apparatus

This section is based on the movie `apparat.exe` which can be downloaded from our website or found in the Movies folder.

Switch to the **Draw** mode and set 50% zoom.

1. From the **Template Window** choose the **Lab Kit** tab from the Template List.
2. Select the **round-bottom flask** by clicking on it. Click on the workspace to place the selected template.
3. Click the right mouse button to hide the template shadow.
4. Open the Template Window. Select the **vitreux distillation column with connecting adapter**. Connect it to flask by clicking.
5. Click the right mouse button to hide the template shadow.
6. From the Template Window choose **thermometer** and connect it by clicking as shown.
7. Click the right mouse button to hide the template shadow.
8. From the Template Window choose the **distillation column** and place it on the workspace near the apparatus by clicking.
9. Click the right mouse button to hide the template shadow and switch to the **Select/Move/Resize** tool.

10. Click on any selection handle (black squares surrounding the distillation column) to quickly switch to the **Select/Move/Rotate** tool.

11. Rotate the selected object 60° counter-clockwise by dragging any selection handle. The informative cursor will show you the angle of rotation (if the corresponding option has been selected in the General tab of the Preferences dialog box (Options menu)). Note, that holding down the **Shift** key while rotating will constrain the angle of rotation to 15° and will help you to rotate the object exactly by 60°.

12. Move the column by dragging to attach it to the apparatus.

13. From the Template Window select the **vacuum adapter** and attach it to apparatus.

14. Complete the drawing by connecting the **receiving flask**.
7.4 Drawing a Two-chain DNA Strand

This section is based on the movie `dna_ch.exe` which can be downloaded from our website or found in the Movies folder.

Switch to the **Draw** mode.

1. Select the **Polyline** tool:

1. Drag vertically down from the starting point of the curve to stretch the control line;
2. Release the mouse button.
3. Move the mouse to the right to draw the curve.
4. Drag vertically down to stretch the control lines. By changing the length of the control lines you can modify the form of the curve.
5. Release the mouse button and double click the right mouse button to finish drawing the curve and to switch to the Select/Move/Re-size tool.
6. Place the mouse pointer over the selected curve; while holding down the Ctrl and Shift keys drag it down (holding down the Ctrl key while dragging leaves behind an instant copy of the object and if holding down the Shift key forces the object to move strictly vertically or horizontally).

7. Select both curves by dragging the selection rectangle around them or by clicking on each of the curves while holding down the Shift key, then choose Connect Lines (in the Object menu) to connect the right ends of the curves.

8. Choose the Edit Nodes tool on the Editing toolbar (at the top of the workspace) and do the following to draw a segment:
   a) Click on the Connect Vertices button to connect the end nodes with a line.
   b) Select the right two nodes by dragging the selection rectangle around them and click on the Convert to Line button.
   c) Click the right mouse button to switch to the Select/Move/Re-size tool.

9. Make a copy of the obtained segment by dragging it while holding down the Ctrl and Shift keys as described in step 2. Click on the Flip Left to Right button to flip the segment and then click the Send to Back button to send the segment to the background.

Note:
- It takes some time to correctly position the segments by moving them. To align their position, select both segments and apply the Center Horizontally tool to the segments.
- To ease the process of object manipulation you can group the individual objects into one object. Select the objects you want to group and click on the Group button. To ungroup the grouped objects click the same button (note that if the selected object is a group of objects the Group button is active.)
10. Select both segments by dragging or clicking while holding down the Shift key and make a copy of them. Correct the position using the directions in the previous step:

![Segment Copy Example](image)

11. Select the segments marked with bullets by clicking on them while holding down the Shift key. Double click on any of them to open the Objects panel. In the Fill tab specify the following settings:

```
Style - Shade ;
Color - white;
Pattern -
Shade -
```

and click Apply:

![Objects Panel Example](image)

12. Select the other two segments (they are marked with crosses in the figure) and specify the following settings:

```
Style - Shade ;
Color - white;
Pattern -
Shade -
```
Click **Apply** to obtain the following spiral:

13. Select the whole spiral by dragging the selection rectangle so that it includes all the spiral segments and make a copy of it by dragging while holding down the **Ctrl** key. Click on the **Flip Left to Right** and then **Flip Top to Bottom** buttons:

14. Select the segments marked with bullets by clicking on them while holding down the **Shift** key and click on the **Send to Back** button.
7.5 Drawing Lipids and Micelles

This section is based on the movie lipid.exe which can be downloaded from our web site or found in the Movies folder.

7.5.1 Drawing the lipid

Switch to the Draw mode.

1. Select the Ellipse tool. Drag in the workspace holding down the Shift key to draw a circle. Click the left mouse button on the black color from the Color Palette (on the Status Line) to color the circle.

2. Choose the Polyline tool. Click repeatedly in the workspace near the circle to draw the carbonic tail and click the right mouse button to finish drawing.

Note:
- To easily draw the symmetric zigzag line choose the Snap on Grid and/or Show Grid command (Options menu).

3. Choose the Edit Nodes tool.
a) Select all the nodes of the drawn polyline by dragging the selection rectangle around it. Note that selected nodes become black.

b) Click on the Convert to Curve button and then on the Smooth button.

c) Click the right mouse button to switch to the Select/Move/Re-size tool.

4. Position the mouse pointer over the curve and drag it holding down the Ctrl key to leave the copy of the curve behind.

5. Arrange the tails as shown by dragging them.

Note:

• If you select all the elements of the phospholipid and click the Group button, you will be able to manipulate them as a single object, e.g. rotate it using the Select/Move/Rotate tool.

• Using the copying feature (Ctrl + drag), Group, Rotate 90°, Select/Move/Rotate, as well as the aligning and flipping tools, you can try to create the following picture of micelle:

Try drawing the micelle picture using the copying feature (Ctrl + drag), Group, Rotate 90°, Select/Move/Rotate as well as the aligning and flipping tools:
7.6 Creating a Poster

Using ChemSketch you can quickly draw a poster and print it on paper of any format. ACD/ChemSketch will automatically separate the poster into pages; the only thing you have to do (besides design them) is attach them.

This section is based on the movie poster.exe which can be downloaded from our web site or found in the Movies folder.

1. From the File menu choose the Page Setup command.

2. Select the Poster tab in the dialog box that appears. Set the number of standard pages you want your poster to consist of by clicking on the spin buttons. Note that you can see the automatically calculated size of the poster in the Virtual page size field:

3. (Optional) In the Size & Orient and Margins tabs set the page margins and orientation.

4. Click OK

5. Draw your poster using the tools in the Structure and Draw modes. Note that you can use the Paste and Paste Special commands from the Edit menu to insert objects (text, pictures and etc.) created in other Windows applications. You can also edit these objects using OLE.
6. (Optional) Mark the View Printable area check-box in the General tab of the Preferences
dialog box (Options menu) if you want to see how your poster will be divided into individual
pages while being printed.

7. Choose the Printer Setup command from the File menu.

8. In the Select Printer dialog box do the following:

9. Choose the Set Up button.

10. Select the Print TrueType as Graphics option in the installed printer setup dialog box. Note
that this step may be different for each printer.

11. Click OK.

12. Choose the Print command from the File menu or click the Print button on the General
toolbar to print your poster.

13. Attach the pages.
8. Calculating Macroscopic Properties

8.1 Overview

ACD/ChemSketch is so versatile in its drawing capabilities that it is possible to overlook the unique macroscopic properties predictions which are built right into it. These include prediction of

- molecular weight;
- percentage composition;
- molar refractivity;
- molar volume;
- parachor;
- index of refraction;
- surface tension;
- density;
- dielectric constant; and
- polarizability.

In this Chapter, the simple means to calculate these properties is described. The algorithms for calculating these properties are briefly described, and a summary of the agreement is shown for calculated vs. experimental values for several hundred compounds.

Please note, that in this chapter, “properties” is used to mean physico-chemical values, in contrast to the general use of “properties” in ChemSketch documents, where the characteristics of the graphic display are referred to. For example, the Structure Properties command in the Tools menu permits you to set font size, bond thickness, color, etc.
8.2 Calculating Macroscopic Properties

8.2.1 Menu Command
To determine any one or all of the following molecular properties, when in Structure mode, draw a structure, select \textbf{Tools} and then choose the \textbf{Calculate…} menu command. This permits calculation of

- molecular weight;
- percentage composition;
- molar refractivity;
- molar volume;
- parachor;
- index of refraction;
- surface tension;
- density;
- dielectric constant;
- polarizability; or
- all properties at once.
Once chosen, the calculated property is displayed in a Calculation Result dialog box. The text content of this can be immediately pasted on the ChemSketch screen if desired by clicking on the Copy to Editor button. For example, choice of Tools/Calculate…/All properties for benzoic acid will show the following dialog within seconds:

![Calculation Result Dialog]

### 8.2.2 Automatic Display on Status Line

It is also possible to view the macroscopic property directly on the status line as shown:

![Status Line Display]

Just click on the box to the far right on the status line and choose the property desired. By default, this is set to molecular weight. In the example shown, the dielectric constant, \( \varepsilon^{20} \), has been specified.
8.3 Algorithms for Calculating Macroscopic Properties

At the heart of the additive-constitutive calculation algorithm of all physico-chemical properties in ChemSketch lies the presumption that these properties can be estimated using additive atomic or group increments. Apart from molecular weight (MW), which is trivial to calculate, the algorithms may be divided into three general groups:

- basic macroscopic properties: Molar Volume (MV), Molar Refractivity (MR) and Parachor (P_r);
- derived macroscopic properties: density (d), refractive index (n) and surface tension (γ); and
- the dielectric constant ε (Permittivity).

Basic macroscopic properties such as Molar Volume (MV), Molar Refractivity (MR) and the Parachor (P_r) are calculated first for the input structure. The atomic additive increments in such an algorithm depend on the bonds (single, double, aromatic, etc.) of this atom and on neighboring atoms. ChemSketch rapidly analyzes the input structure to determine the class of each atom, i.e., whether it is cyclic, aromatic, aliphatic, etc.

The prediction algorithms for density (d), refractive index (n) and surface tension (γ) are founded on well known physico-chemical formula which can be found in most physical chemistry textbooks. These express d, n and γ as functions of MV, MR or P_r. Once the MV, MR or P_r have been predicted by additive means, it is straightforward to predict d, n and γ using these formula.

The determination of the additive-constitutive atomic increments for MV, MR and P_r were obtained internally by ACD using large experimental data bases relating structure to density, refractive index and surface tension. The MV, MR and P_r were recalculated from d, n and γ. These parameters are proprietary information of Advanced Chemistry Development.

The prediction of the dielectric constant ε (permittivity) resembles very closely the prediction of Boiling Point, which is a separate ACD product from ChemSketch. Senior scientists at ACD discovered an additive function, which relates the dielectric constant to other macroscopic properties which can be additively treated, such as MV. Once this relationship was discovered, the additive-constitutive atomic increments for this function were obtained using large Data Bases consisting of molecular structures and their observed dielectric constants. Using the function and estimated MV for the input structure, its dielectric constant can be quickly predicted.

8.3.1 Molar Volume, MV

By definition,

\[ MV = \frac{MW}{d}. \]

ChemSketch calculates molar volume from additive increments. The additive atomic increments were obtained using a Data Base of density and calculated MW.

8.3.2 Molar Refractivity, MR

The Lorentz-Lorenz equation relates refractive index, density, and refractive index:

\[ MR = \frac{n^2 - 1}{n^2 + 2} \cdot \frac{MW}{d}. \]

ChemSketch calculates molar refractivity from additive increments. The additive atomic increments were obtained using a Data Base of density, refractive index and calculated MW.
8.3.3 Parachor, $P_r$

By definition,

$$P_r = \left| \frac{MW}{d} \right| \gamma^{\frac{1}{4}}$$

ChemSketch calculates the parachor from additive increments. The additive atomic increments were obtained using a Data Base of density, surface tension, and calculated MW.

8.3.4 Density, $d$

By definition,

$$d = \frac{MW}{MV}$$

ChemSketch calculates the density from MW and the calculated molar volume (see above).

8.3.5 Refractive Index, $n$

By the Lorentz-Lorenz equation,

$$n = \sqrt{\frac{2 \cdot MR + MV}{MV - MR}}$$

ChemSketch calculates the refractive index from the molar volume and molar refractivity, both of which are calculated as above.

8.3.6 Surface Tension, $\gamma$

By definition,

$$\gamma = \left| \frac{P_r}{MV} \right|^4$$

ChemSketch calculates the surface tension from calculated MV (see above) and calculated $P_r$ (see above).

8.3.7 Dielectric Constant, $\varepsilon$ (Permittivity)

$$f(\varepsilon) = f(MV, \text{AdditiveFunction})$$

ChemSketch calculates the dielectric constant from calculated MV (see above) and a proprietary empirical additive function.

8.3.8 Polarizability

This property is calculated from the Molar Refractivity (MR) (see Section 8.3.2) as follows:

$$\text{Polarizability} = 0.3964308 \cdot MR$$
8.4 Correlation Statistics with Experimental Data

8.4.1 Distribution of Molar Refractivity Prediction Error

Vertical scale: Number of Tested Structures
Horizontal scale: ACD Molar Refractivity Estimation Error
Number of tested structures: 592

\[ MR_{\text{exp}} = 0.99901(\pm0.00067) \, MR_{\text{calc}} + 0.026(\pm0.025) \]
\[ R=0.999867, \text{ StD}=0.23 \]
8.4.2 Distribution of Molar Volume Prediction Error

Vertical scale: Number of Tested Structures
Horizontal scale: ACD/Molar Volume Estimation Error
Number of tested structures: 671

\[ MV_{\text{exp}} = 0.9989(\pm 0.0020) \ MV_{\text{calc}} + 0.18(\pm 0.29) \quad R=0.998626, \text{StD}=2.74 \]
8.4.3 Distribution of the Parachor Prediction Error

Vertical scale: Number of Tested Structures
Horizontal scale: ACD/Parachor Estimation Error
Number of tested structures: 377

\[ P_{exp} = 0.9978(\pm0.0015) \cdot P_{calc} + 0.68(\pm0.46) \]

\[ R=0.99958, \text{Std}=3.11 \]
8.4.4 Distribution of the Refractive Index Prediction Error

\[ n^{20}_{\text{exp}} = 0.98035(\pm 0.0073) \cdot n^{20}_{\text{calc}} + 0.028(\pm 0.011) \quad R=0.982, \text{StD}=0.012 \]
8.4.5 Distribution of the Density Prediction Error

Vertical scale: Number of Tested Structures
Horizontal scale: ACD/Density Estimation Error
Number of tested structures: 671

\[ d_{\text{exp}}^{20} = 0.9947(\pm0.0036) d_{\text{calc}}^{20} + 0.0052(\pm0.0036) \quad R=0.995683, \text{StD}=0.028 \]
8.4.6 Distribution of the Surface Tension Prediction Error

Vertical scale: Number of Tested Structures
Horizontal scale: ACD/Surface Tension Estimation Error
Number of tested structures: 432

\[ s^{20}_{\text{exp}} = 0.998(\pm 0.018) s^{20}_{\text{calc}} + 0.08(\pm 0.53) \]

\[ R = 0.934720, \text{ StD} = 2.84 \]
**8.4.7 Distribution of the Dielectric Constant (Permittivity) Estimation Error**

\[ \varepsilon_{\text{exp}} = 1.005(0.033)\varepsilon_{\text{exp}} - 0.013(0.072) \]

\[ R=0.9588, \text{StD}=0.079 \]

***Note*** Derived only for hydrocarbons
9. Special Function Keys

The ChemSketch Window is an extremely versatile molecular structure input editor. For this reason, several ACD software items are now accessible as single buttons from the ChemSketch interface. This Chapter describes two special add-on modules which can also be accessed from the ChemSketch interface. ACD/Tautomers is now included with both ACD/ChemSketch commercial and freeware; and ACD/Dictionary is available only with the ACD/ChemSketch commercial software.

9.1 Tautomers

The Tautomers button will automatically check the structure that is drawn alone in the ChemSketch Window or which is selected from several other molecules and will automatically search for Tautomeric forms.

ACD/Tautomers is such a popular request item that we cover it here in some detail. For more information on Tautomers, as well as many examples of overlooked tautomers in the chemical literature, please refer to the ACD/Tautomer User's Guide.

1. Using the above technique draw the following structure:

2. Select the structure (use the Select/Move tool), click on the Check Tautomeric Forms button on the Top toolbar. The program starts generating and checking tautomeric forms of the drawn structure and when the process is finished, the following dialog box is displayed:
3. To browse through all of the generated structures, click on the Next or Prev buttons.
4. To replace the drawn structure with the currently displayed structure, click on the Replace button.
5. Please refer to the ACD/Tautomers User’s Guide for more information!

9.2 Dictionary

ACD/Dictionary is an add-in “Look-up” module, now included with all commercial copies of ACD/ChemSketch. It is extraordinarily useful at finding “chemicals” by their common names.

ACD/Dictionary finds chemical structures according to their chemical name. It contains almost 48,000 systematic and non-systematic names and their corresponding molecular structures. The dictionary is searchable by both the full chemical name and name fragments.

Although the many features of ACD/Dictionary are covered in the ACD/Dictionary User’s Guide, we introduce it briefly here.

On the right References toolbar, click on the Dictionary button to view the ACD/Dictionary screen:

Note:
- If you purchased ACD/ChemSketch but do not see the ACD/Dictionary button in the ChemSketch Window when you are in Structure mode, please verify that you have correctly entered TWO registration numbers at the time of installation – one for ACD/ChemSketch, and one for the ACD/Dictionary add-in.

Please refer to the ACD/Dictionary User’s Guide for more information!
10. Goodies

What are the "goodies"? They are additional buttons that extend the functionality of ChemSketch. They are, actually, implemented as ACD/ChemBasic programs associated with 22 new ChemSketch buttons. ACD/ChemBasic is a special programming language that enables you to customize ACD software, and we think this is a great way to show off how useful it is—and at the same time make your ChemSketch freeware even more versatile!

Note that you do not need to know anything about ACD/ChemBasic (although, if you wish, you can learn it using the Goodies' code as example).

These helpful buttons are available on our Web site (http://www.acdlabs.com) for free. They are easy to install and to use. Just follow the installation instructions provided on the Web page and enjoy the new ChemSketch functionality.

Note also that you can remove these new buttons from your ChemSketch toolbar at any time.

**Notes:**
- ChemBasic Goodies buttons are only available when you are in Structure Mode. Switch to Structure Mode to use these buttons.

Below is the list of Goodies buttons that are available at the moment on the Web site:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>* How to use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert Page</td>
<td>Inserts blank pages at any place within your ChemSketch document. Note that the usual way - through a Pages/New menu - adds a page to the end of document.</td>
<td>* Go to the page before which you want to insert a blank page and click the Insert Page button.</td>
</tr>
</tbody>
</table>
| Clone Page  | Clones current page (together with its contents) a given number of times - it is very useful for filling in the document with page templates, tables, titles, etc. New pages are added at the end of a document. | * Make the page which you wish to clone active.  
* Click the Clone Page button.  
* In the dialog box that appears specify the number of clones and click OK. |
| Move/ Copy Page | Moves and copies pages - i.e. changes page order in your document. | * Go to the page which you wish to move or copy.  
* Click the Move/Copy Page button.  
* In the dialog box that appears type in number of the page after which you wish to place the current page and click OK.  
* Select Yes in the Message Box which appears if you want to copy the current page. Select No if you want to just move it. Click Cancel to stop program execution. |
<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>How to use</th>
</tr>
</thead>
</table>
| Delete Pages           | Deletes a range of pages at a time.                                       | • Click the Delete Pages button.  
• In the dialog box which appears type the sequence of pages to delete.  
• You will be prompted about disabling Undo after program execution. Choose OK if you wish to delete the pages. Click Cancel to abort program execution. |
| Annotate Document      | Annotates your documents based on the content of the leftmost top textbox on each page. This is very convenient for managing large documents and presentations. | • Open or create a document.  
• Click the Annotate Document button.  
• After program execution click on the page counter from the bottom status line to see page names.                                           |
| Sketch-to-VRML Converter | Exports all the molecules in a current page into a VRML 2.0 file, which you may then view with Cosmo, GLView, or any other VRML browser. | • Draw structures which you wish to export in one page.  
• Click the Sketch-To-VRML Converter button.  
• Select OK in the Ready to export... message box which appears (or CANCEL to abort program).  
• Type in the file name and path and click OK. Note that if you have typed in the filename only, the program will place the resulting WRL file in the same directory with sk2vrml.bas.  
• Specify the desired structure presentation by typing the corresponding letter in the next dialog box and click OK. |
| SDF-to-Sketch Converter | Imports the data (molecules, texts, etc.) from a file in MDL's SDF format into ChemSketch document. Each record in the SDF file becomes a page. LIMITATION: no more than 100 records may be imported (ChemSketch document may contain 100 pages maximum). If the SDF file contains more than 100 records then you will be prompted about partial SDF conversion (and the number of successfully imported records). | • Click the SDF-To-Sketch Converter button.  
• In the dialog box type in the full path and name (or mask - "*" and "?" are acceptable in the file-mask) of the SDF file which you want to import and click OK. If you type in the filename without specifying the full path, the program will search your SDF file in ChemBasic program directory. So, if you place the needed SDF file in the same directory with sdf2sk.bas then it will be enough to specify the file name without a path. If you place the SDF file in ChemBasic's program sub-directory then it will be enough to type in only the sub-directory name.  
• If searching the result contains more than 1 file, the program will suggest you select one, then will ask for the field name. Specify the field name and click OK. |
| Document Browser       | Looks through the directories to find specified ChemSketch documents as well as to search ChemSketch documents for the text string without opening them. | • Click this button and follow the instructions that appear in the messages. This is a very useful tool for searching and previewing ChemSketch documents |
| Table Wizard           | Creates tables or/and aligns objects according to a specified number of rows and columns | To create a table and place the drawn objects into it  
• Click the Table Wizard button.  
• You will be informed about the number of objects on the page and some suggestions on how to align them. Select YES.  
• Specify the number of rows and columns in the table.  
• Then choose whether to create borders in the table.  
To create an empty table  
• Run the Table Wizard with the blank page active.  
• or  
• Select NO in the message box that suggests that you should align objects. |
<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>* How to use</th>
</tr>
</thead>
</table>
| Replace Element        | Replaces all the atoms of a given type with atoms of another type in a chemical structure. This is very useful for drawing, for example, perfluorinated structures. | Note that program execution is possible only with a single structure on the page.  
- Draw or leave only one structure on the page and click this button.  
- In the dialog box that appears specify the element which you want to be replaced and click OK.  
- In the next dialog box specify an element that should replace the one specified before and click OK. |
| Solution Calculator    | Calculates the weight of a compound required for preparing a solution of the user-defined volume and molar concentration. | Note that program execution is possible only with a single structure on the page.  
- Draw or leave one structure on the page and click this button.  
- Specify the required molar concentration and solution volume in the dialog box.  
- See the result in the Message Box that appears. |
| Label Printer          | Quickly creates labels for chemicals and print them on the Avery Standard (45 template sheets included) or your own sheets |  
- Draw structures for which you want to create labels and click this button.  
- You can create labels for structures from the *.sdf file if you run this program with an empty active page.  
- For more information see lprinter.txt provided in the Goodies directory. |
| Peptide Builder        | Builds a 3D peptide structure from the amino acids sequence.              |  
- Refer to the pepbuild.sk2 provided in the Goodies directory as a guide to using this button. |
| Carbohydrate Builder   | Builds a structure from carbohydrate abbreviated names.                  |  
- For information about how to work with this button refer to the sugarsk.txt file that you can find in the Goodies directory. |
| Reorder Pages          | Allows you to cut-and-paste or copy-and-paste a sequence of pages to a new position within the same document. |  
- Open the document within which you want to reorder the pages.  
- Click this button and follow the instructions in the messages. |
| Rename Pages           | Changes the name of pages                                                |  
- Open the document.  
- Click this button.  
- Type in the number of a page you want to name and click OK.  
- Type the name and click OK.  
- The names of the pages are shown when you click on the “Page 1/1” button at the bottom of your ChemSketch Window. |
<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>* How to use</th>
</tr>
</thead>
</table>
| Insert Page Numbers/Annotations | Inserts page numbers or complex annotations in your document. Note that annotation will be inserted in a left-bottom corner of the page. | - Open or create a document.  
- Click the Annotate Pages button  
- Type in a page annotation template in dialog box that appears and click OK.  
Annotation template keys:  
- $P$ - inserts page numbers  
- $SN$ - inserts pages names (that can be inserted using Rename Pages goody or using Pages/Rename command)  
You can also include any fixed text into your annotation template.  
For example:  
Template “$P$” will insert page numbers  
Template “$SN$” will place page names in a left-bottom corner of each page  
Template “Page $P$” will insert “Page 1”, “Page 2”, etc. annotations  
Template: “Page $P$: $SN$” will insert “Page 1: Page Name”, etc. Annotations  
Template that does not contain any keys will insert fixed text for each page - you can, for example, sign all pages with your name. |
| Create HTML | Exports all the selected pages of a current document into an HTML file, which you may then view with your favorite web-browser. **Note:** Requires ChemSketch 4.01. | - All the details may be found in FillTmpHelp.doc provided in the Goodies directory. |
| Sketch-To-SDF Converter | Exports all the structures from the current page or from the whole document into an SDF file. | - Open the page with the structures you want to export.  
- Choose this button and choose what do you want to import - the current page or the whole document. Click OK.  
- Specify the name and the path for an *.sdf file. Note that if you type in the filename only, the program will place the resulting sdf file in the same directory with expsdf.bas file. |
| Explicit Hydrogens | Explicitly shows hydrogens in the drawn structure(s). | - * Draw structure(s) on the page and click this button.  
**Note:** you can use standard ChemSketch command - Tools/Remove Explicit Hydrogens - to revert this goody action. |
| Remove Spectator Ions (Desalt) | An SDF file that contains one or more salt structure entries can be changed to a “one-molecule-per-entry” SDF file. This button removes the smallest ion, either by MW or by number of atoms. For example, sodium acetate will have the sodium atom removed, and acetic acid will remain behind. (Note: the molecule left behind is put into neutral form.) | - Specify the name and the path for an *.sdf file. Note that if you type in the filename only, the program will look for file in the Goodies directory.  
- Then define a criterion for smallest part: mass or atom.  
- The resultant SDF file will be saved in the same directory with the one you have specified under the newfile.sdf name.  
A special sample file, “salts.sdf” with 5 salts in it is placed in the Goodies directory for testing.  
Hint: use the “Import SDF” Goody to double-check Newfile.sdf. |
| Nucleic Acid Builder | Builds a 3D nucleic acid (DNA, RNA) structure (one or two chains) from your input sequence. | - Click this button and follow the instructions from the messages. |